
Have you ever thought, about which software is being 

used in any company to store your records? Have you 

ever thought, about which software is used to store the 

details of  the patients and doctors are stored in a 

hospital?  Have you ever thought about which 

software the details are stored for the tickets sold for 

any show? The answer to the questions asked above is 

“DATABASE”. Now again a question arises what  is 

a DATABASE?

 Let's know more about it.

Database 

.... . A database is an organized collection of  data. A database 

i s  an electronic system that allows data to be easily accessed, 

manipulated, and updated.

Types Of Databases: There are mainly two types of  

databases:

Flat File Database:   When the data is stored in the form of  a 

plain text file and cannot incorporate multiple tables. For example, 

Microsoft excel.

Relational Database:  When the data is stored in a form where the data items are 

related to one another. It supports multiple tables which organize the text in rows and 

columns. For example Microsoft Access, Microsoft SQL, and Oracle.

Structure of Access Database:

Databases in Access are composed of  four objects: tables, queries, forms, and reports. 

Together, these objects allow you to enter, store, analyze, and compile your data however you 

want.
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  Tables:   Store your data in your database.

  Queries:   Ask questions about   information stored in your tables.

  Forms:    Allow you to view data stored in your tables.

  Reports:  Allow you to print data based on queries/tables that you have created.

First Step To Microsoft Access 2016

Let's start with MS Access

Method 1: Click Start > Scroll down and 

click on the Access icon.

Method 2: Type Access in the Search Box 

> Click on the Access icon.

Method 3: Double click the Access shortcut icon 

on the desktop, if  available.

   The default MS Access start window appears on 

the screen. It shows various templates to create   a 

database. We will choose the Blank desktop 

database to create our database file.

Features  Of  Microsoft  Access 

Startup Screen: MS Access opens with new startup screen that provides 

easy access to new database templates, recent databases and their 

locations in the system.

Compatible with Windows 10: MS Access 2016 is fully compatible with Windows10 

operating   system. It also incorporates the latest touch technologies designed for laptop, 

tablet and mobile devices.

Cloud Access: MS Access also facilitates cloud storage. This way the data can be saved 

safely and securely online.

More Database Options: MS Access 2016 provides a wide range of  pre-designed templates 

suitable for different kinds of  work such as creating tables.

Backup Data Option: It protects your database in the event of  a hardware failure, or other 

data loss. It keeps backup of  access databases so that the information is not lost.

Searching Ms Access

Filtered Data

Opening Ms Access



 Linking to Account: MS Access 2016 provides an option to sign in to Office 365 to access 

all your databases. It also manages the Office Theme.

Component Of MS Access 2016

Let us get familiar with various components of  the 

Access 2016

NAVIGATION PANE: This pane is present on 

the left side of  the Access window. It displays the 

name of  the objects used in the database, such as 

Tables, Queries, Forms, Reports, etc.

NAVIGATION BUTTONS: As the name 

suggests, it helps in navigating through the 

records. The Navigation buttons display the 

current record number in an object.

OBJECT TABS: The objects that you have opened in a database appear right above the 

work area in a tabbed form Clicking on any tab displays the contents in the work area. To 

close the current tab, click on the cross button on the right end of  the bar. keyboard, mouse 

can also be wired or wireless.

TELL ME WHAT YOU WANT TO DO: It is a new feature, which can be used to get quick 

help on topics that you are looking for or the commands that you want to use in your 

document.

How To Create A Database

Creating a Database:

Step 1: Start Access and Click on Blank desktop 

database. 

Step 2: Under File Name type a name for thedatabase.

Step 3:To change the location of  where to store the 

database, click the folder icon and select a 

location.

Step 4:Click Create. Access opens in a new table in 

Datasheet  View.
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Creating a Table:

A table is a collection of  data about a specific topic, such as employee information, products, 

or customers. The first step in creating a table is entering the fields and data types. This can be 

done in either Datasheet View or Design View but it is recommended to set up the table in 

Design View.

Understanding Fields and Their Data Types

   Field- an element of  a table that contains a specific item of  information, such as the last name.

   Field's Data Type- determines what kind of  data the field can store.

  
Format Use to Display

Short Text Alphanumeric Data (names, titles etc) upto 255 Characters

Long Text Large amounts of Alphanumeric Data : Sentences & Paragraphs 
64,000 Characters

number Numeric Data

Date/Time dates & Times

Currency Monetary Values

Auto Number The unique value generated by access to reach a new record

Yes/No YES & NO Fields that contains only 1 of 2 values

OLE Object Pictures & Graphs or other Active X Objects from another windows 
based application

Hyperlink A link to a document or file on the Internet

Attachment Attached files such as pics, docs etc

Calculated Expression that uses data from other fields



Understanding Views

There are multiple ways to view a database object. 

The two views for tables are Design View and Datasheet View.

Design View is used to set the data types, insert or delete fields, and set the Primary Key.

Datasheet View is used to enter and view the data for the records.

Switching Between Design View and Datasheet View: Click the View arrow on the 

Home tab and click on either Datasheet View or Design View.

To Create a Table in Design View

Step 1:  Click on the Create tab.

Step 2:  Click on Table.

Step 3: Switch over to Design View on the 

DESIGN tab

Step 4: Prompted to save the table, enter your name 

and click on OK.

Step 5: Type the field names and select the appropriate data 

type for each field continue until all fields are added.

Note: The order in which you 

enter the field names is the order 

the fields will appear in the table.

Setting a Primary key

The Primary Key is the unique identifier for each record 

in a table. Access will not allow duplicate entries in a primary key field. When creating a new 

table, Access automatically creates a field “ID”withthe auto number data type and assigns this 

as the Primary Key.

To Set a Primary Key:

Step 1: In Design View ,position your cursor in the field you 

wish to set as the Primary Key.

Step 2: Click the Primary Key button on the toolbar.

Step 3: Save the table.

 
DATASHEET VIEW

 

 

 DESIGN VIEW 
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Entering Data in a Table 

To enter in a table follow these steps:

Step 1: In Data sheet View, start typing 

the data in to the table by 

pressing the tab key to move to 

the next cell.

Step 2: When you have completed the 

record(row) , press Enter.

Step 3: You canal so click on the New record icon on the Home tab in the Records group.

Navigation in a Table 

NAVIGATION BUTTONS: These 

buttons are like media player button 

which helps in navigating through 

various records of  Access objects. It also displays the current record number.

Use the arrows at the bottom of  the tablet on navigate among records.

Adding A Record  

To add record in a database, follow 

these steps: 

Step 1: Open the table in Datasheet 

view.

Step 2: Place the pointer where you 

want to add new records (say, 

just after the last record of  the 

table).

Step 3: Enter the new record in the table.

                 NOTE: If  you want to insert a record in between a table, perform the following steps:

Select the record before which you want to insert a new record.

Right-click and select 'New Record' option from the drop-down list. A blank tow 

will be  created.

             Insert the record.
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Deleting a Record

To delete a record, perform these steps:

Step 1: Open the table  in Datasheet view.

Step 2: Place the mouse pointer at the extreme left 

of  the row.

Step 3:Right-click the selected record and click  

‘Delete Record’. 

The system asks for confirmation from the user before deleting it permanently from the table.

Sorting Records in Table

Step 1: Position your cursor in the field that 

you wish to sort by clicking on any   

record in the table.

Step 2: Click either the Sort Ascending or Sort 

Descending icon on the Home tab in the 

Sort & Filter group.

Exiting Access
To close a database:

Step 1:  Select the File tab to go to Backstage view.

Step 2:  Select Close.

Step 3:  If  you have any unsaved objects, a dialogue box will appear for each one asking if  you 

would like to save them.

Step 4: Select Yes to save the object, Note close it without saving, or cancel to leave your 

database open.

Opening an Existing Database
Different methods you can use to open existing Access 

databases. 

You can open databases from Windows Explorer or from 

within access itself. 

You can open multiple databases at once, you can also 

create desktop shortcuts that open database objects directly.  

       Note: To open existing databases, we use “Ctrl + O” as the shortcut key.
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Forms allow you to view data stored in your tables.

The Primary Key is the unique identifier for each record in a table. Access will not allow duplicate 

entries in a primary key field. When creating a new table, Access automatically creates a field “ID” 

with the auto number data type, and assigns this as the Primary Key.

 Relational Database: When the data is stored in a form that the data items are related to one another. 

It supports multiple tables which organize the text in rows and columns, For example, Microsoft 

Access, Microsoft SQL, and Oracle.

Tell Me What You Want To Do: It is a new feature, which can be used to get quick help on topics that 

you are looking for or the commands that you want to use in your document.

A.   Fill in the blanks with the correct option:

  

1. Organized collection of  related data is called ___________________.

2. To open existing databases, we use_______________________ as the short cut key.

3. True or False values are stored by using ____________________ data type in Microsoft Access.

4. In Access, the data is stored in the form of  _____________________.

5.To remove a field from a table: In the _________column for the field, click the___________ icon.

Section - I
Objective Type Questions

B.  Write T for the true statement and F for the false one:

1.  A form is used to make both input and output on a table.

2.  NAVIGATION BUTTONS, helps in navigating through the records.

3.  We can work on more than one document at the same time.

4.  Design View is used to set the data types, insert, delete fields, and set the Primary Key.

5.  The Primary Key is the unique identifier for each record in a report.

CTRL+O        Boolean        Database         Action      Delete      Tables
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C. Choose the right option::

1.  Which of  the following database object produces the final result to present

         (A) Forms                                                                       (C) Queries

         (B) Reports                                                                      (D) Tables

2. Which leads you through the process of  creating a table?

         (A) Wizard                                                                      (C)Relation

         (B) Assistant                                                                    (D) Coach

3. A database object in MS Access that stores a question about the data in the database?

         (A) Table                                                                         (C) Query

         (B) Form                                                                          (D) Report 

4.    Which is NOT a method of  creating a table?

         (A) Datasheet View                                                         (C) Layout View

         (B)Design View                                                              (D) Template

5.    A database can be best described as.

         (A) Organized collection                                              (C) Graphical representation                   

         (B) Useful presentation                                                   (D) All of  above

                        

D. Application Based Question:

1.  While creating a table of  a database, Adwitiya is not able to see the table is designed. 
Help her in getting the design view of  the table.

     _________________________________________________________________________

2.  While making a query, Rig is not able to set criteria condition to see all records where 
city is Delhi. Help him in setting the criteria for the field.

     _________________________________________________________________________

Section - II
Descriptive Type Questions:

E.  Answer the following:

1.  Explain the different data types in Access?

_____________________________________________________________________________

______________________________________________________________________________
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1. Tanya wants to add a new table to the existing database. Which option should use to complete 

the task?

      

      _____________________________________________________________________________

2. How to add and delete a field?

      _____________________________________________________________________________

      _____________________________________________________________________________

      _____________________________________________________________________________

3. How to create a table and primary key?

      _____________________________________________________________________________

      _____________________________________________________________________________

       _____________________________________________________________________________

4. What are the main components of  MS Access?

      _____________________________________________________________________________

      _____________________________________________________________________________

      _____________________________________________________________________________

5. How to create a database?

       _____________________________________________________________________________

 _____________________________________________________________________________
 _____________________________________________________________________________
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Create a database library with the following two tables. Enter ten records in both the tables.

Table : Books 

Modify the table and insert the field name Price before Quantity and set the type as number. 

Insert a new field Date _of_Purchase at the end of  the list of  Date/Time type .

Move the Date_ of_Purchase before Price field by Drag and Drop method .

Similarly move Author field before Price field.

Select the six record and delete it .

Insert a new record 

Go to record 1 and modify the Price and Author data values .

Short the table Books according to Book_Name field in descending order .

Change the view from Datasheet to Design and then again change to Datasheet view .

Save and close the table by pressing Ctrl+W keys.

Table : Students 

Create the Table Students and add 10 records .

Rename Stu field at Stu_ name .

Add two new fields at the end of  as issued and Date_ of_ Issue .

Move Issue field after Class field.

Delete record 7 .

Modify the value of  record  number 6 in Stu_ID (and observe).

Modify the value of  Issued to No in records 7 to 10 .

Short the table in ascending order of  Date_ of_ Issue .

Delete all records from 8 to 10 .

Save the table and exit Access .

Divide the class into groups to discuss on:

     Why database? It’s importance, Features and Microsoft Access as DBMS .

     Data type using Microsoft Access and their usages. 

https://microsoft-access.en.softonic.com/

https://en.wifipedia.org/wiki/Microsoft_Access

62

about:blank

	1: 52
	2: 53
	3: 54
	4: 55
	5: 56
	6: 57
	7: 58
	8: 59
	9: 60
	10: 61
	11: 62

